5. What is icon ?

What is Recycle Bin 7

What is window explorer ?
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ncept of operating system 9
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& Short Answer
1. What is the basic co
5> How you will turn off th

How you will open windows
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& Long Answer
What are the basic functions of operating system ?

L
3 What is window explorer ? What are the five views of window explogy, € @ . - € @ E . - € ! 37C1 @H?—/g\

: i / folder. . . :
4. Write the steps to delete file F—_ l Objective of Learning J_ \
4. What is paint ? What are the steps to start MS Paint ?
; 3.1 MS Word : Introduction to Word Processor
5. Describe the functions of mouse button ? _
8.2 Creating, Saving, Opening Document

Answers Key ]((((H 8.3 Print & Print Preview

3.4 Closing of Document

1. Desktop, 2. GUL 3. Icon, 4. Desktop, 5. Shortcut Icons
| 3.5 Editing Document, Formatting Docum
1. False, 2. T 3 J
se rue, 3. False, 4. True, 5. False. 3.6 Bold, Iialic, Underline, Font Tvpe, Size, Color Chang
3.7 Alignment of Text (Left, Right, Center & Justified)

3.8 Margins — Left, Right, Top and Bolotm
3.9 Formatting Paragraphs

3.10 Adding Header and Footer

3.11 Page Numbering

3.12  Using Grammar and Spell Check Utility
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@ 3.1 MS WORD : INTRODU

Word Processor :
are [t 1s also called word py, .
are. It Dlacegsmg

Word processor is an important softw b :
written with it are directly Pringeg

software. It is used to type letters, the words

on paper.
: = ; . cument ty i
Word processor is used to create document Do df vped in Worq
: To can ¢ {. correct and for: 1
processor appears on the monitor. We can check. corr i mat it befope
printing etc. We can save the document for further editing.

. !.. , Software .

1. MS-Word
2. Word Pad
3. Note Pad
4. Word Perfect

. Corrections can be checked before printing in word processor.
) It is not required to type again and again as in a typewriter.
3. Created document can be saved for future use.

4. You can edit the document.

5. You can format the data.

-1 MS-Word allows us to format the text by applying various text
styles like Underline. Bold Space. Italics, Subscript, Superseript, or strikes
through etc. We can apply the commonly used stages by using the
corresponding buttons from the Formatting Toolbar or using the different keys.
These kevs are applied to the selected Text only.

Earlier typewriters, either manual or electronic were used to type
documents. In those tvpewriters, words were np :
i ents hose }.]){“r’ll( rs. words were printed direct Iy on the paper. Text
tvped using a typewriter will have sty TR :
¥p E Yp er will h:i\l to hl [_\-p(ld again i 1t contains errors. Ir

(9th)

CTION TO WORD P R“CESSOR

ou want te

complete L€

you can cre
mputer sereen, checked for errors and corre
cot i

, have more than one copy of the same document, you have to type
<t document again. Word Processing software has changed the way

ate text documents. In Word Processors, text can be seen on the
cted. before it is printed.

gtarting MS Word

(i How

Start — All Programs — Microsoft Office Microsoft Word
Or

Type"Word" in search bar and press enter button from keyboard.

(ii) Pax

File Menu p
\

Ribbon —g. -
Group (Font) = {

Text Area

T

te of MS Word window :
Maximure

Minimize

Close

Quick Access Toolbar Tabs

v e -« - f.;:_.-;. EF n
B/ === “|EEEE = » 'lf\l
> -

LS A A A A S | B | - o

i AP Computer Books

| 1 -NYQF_{"T. = T
Total No. Status Bar Documeni Zoom out Zoomin
OF Words View

I“ig. The main parts of MS Word Window

Page No
O File

L File mena ¢ In the upper-left corner of the Word window is File Menu.

When you click File Menu, a dropdown, a file menu appears. You can use this

(4th)
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menu to create a new file, open an existing file, save a file and Perfopy, \
. .

other task.
's
L -y 5 (
L A “ . Customive Quich Aoceni Tooibay
o .. (W] y‘l
il sne - .
i
B see s
3 Oeen
 Cese
v ¢
v R
Recent
New

Fig. Quick Access Toolbar

Fie, File menu

. Q : S ol - Above File Menu is the Quick Access toolbar
The Quick Access toolbar provides access to commands you frequently use. By
default Save, Undo and Redo appear on the Quick Access toolbar.

_\lomu [ohe : Tabs are similar to the menu system of MS Word 2003,
instead of having dropdown menus New Version of MS office created the Tab
and Ribbon system. When vou select a tab it will display the Ribbon associated
with that tab. Here everything has been changed into button form. Tabs are
task oriented such as Home, Insert, Page Layout, References, Mailings, Review,
view and within each tab, the related sub-tasks are grouped together.

Tabs

Fig, Tabs

- Ribbon tabs is used to display Ribbons. In Ribbon there are
many buttons that are grouped into categories such as Clipboard, Font and
Paragraph. In Microsoft Word, you use the Ribbon to issue commands to tell
Microsoft Word what to do. The Ribbon is located near the top of the screeh,

L4 (9th)

bi‘lf’w the

Quick Access toolbar. At the top of the Ribbon are several tabs,
b displays several related commands (groups). Within each group
Jated command buttons. You click buttons to issue commands or
yus and dialog boxes.

Jicking a 1
ghere are re
to access s

Nocumant? - Wiorecg Word (Product Actvanon Fatied

"ig. Ribbon

* : You may find a dialog box launcher in the

b t;;rﬁ-right corner of every group. Clicking the dialog box launcher gives you
0

access to additional commands via a dialog box.
£0-0a - Docxr
a L Bow L oA s A %

'T,BIU'*‘-f P

——— i — — __kmslog&)x
Launcher
7 Ruler : Ruler is found below the Ribbon. You can use the ruler to change
the format of your document quickly.
Ruler

4 Test Arcen : Below the ruler the large area is called the text area. You
can type your text in the text area. The blinking vertical line in the upper- left
corner of the text area is the cursor. It marks the insertion point. (when

you type text).
3. Title s - The title bar displays the title of the document on which you
are currently working. Word names the first new document as Document 8

o (]




, ot cnn assipn the document o diffog,.
When you save your document, vou cin assig lore i |”““'

Fitde baa

. EEECTETCC

_ gy et P | ens Aeodgewi W gt A Varw 4 ‘

Fig. Title Bar

T U \ ¢ anned H LR
. LA ' FLieiny ang 101 (LIRS

Lies s The Vertieal and Horizaongg) S|

bars enable you to move up-down, and across your document simply

Seroll Bar

»., - \ e N @ =
Status Bar

Fig. Displaving Status Bar and Scroll Bar

by draging the icon located on the scrollbar. The vertical scroll bar is located
along the right side of the screen. The horizontal scroll bar is located above

the status
bar.
10. Status Dar: The status bar appears at the bottom of the window and

provides information such as the current page and the number of words in your
document.

i1l. Document Vi : In word. vour can display your document in one of

the faIlumnv five views

(1) Print Layout : The Print Layout view shows the document as it will
look when it is printed.

(i1) Full Ser K.

i) Full 8 Ay . Reading Layout view formats vour screen to
make reading vour dor.ument more comfortable,

(iii) Web Lavi

: Web Layout view enables you t

1 ) see your document as
it would appear in g hrrm ser such as

Internet Explorer.

6 | (Gth)

\\""

€ puthine View
ot
Illlil.,rllll iy

'Lé /le'-

AP RSV LR it oot o = U %5

Lirar ot Fastirn it
W Lo hraft View
ot | "5”'"'
Outline View : Outline view displays the document in outline form.
(iv) *7* '
praft View : Draft view is the most frequently used view. You use Draft
v) P .
( to quickl.\’ edit the document.
view : . .
i) Work A - I'rec space 18 called work area. It 15 used for typing your
(vi )
gext

jal Features s of MS Word

Spec
Following are the special features of MS Word:

1. Allows you to insert text anywhere in the document.

9. You can erase characters, words, lines, or pages as easily as you can cross
them out on paper.

3. You can cut and paste a section of text : From one place in 2 document
to somewhere else. You can also paste a section of text.

4. You can define various page sizes and margins, and the word processor
will automatically readjust the text so that it fits to page.

5. It allows you to direct the word processor to search for a particular word
or phrase. You can also replace one character/word with another.

6. You can change fonts within a document such as bold, italics, and

underlining and can change the font size.
7. It allows you to embed graphs into a document.

8. MS word allows vou to specify customized headers and footers that the
word processor will put at the top and bottom of every page. The word processor
automatically keeps track of page numbers so that the correct number appears

on each page.

-t
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9. 1t specifies differont margins within a sigle document ang
. » Ny,
various methods tor indenting paragraphs. | Cify
10 1t provides the fucility of macro which s 2 hat of commands (hat
, Sty
lot of tume, Uy
11, 1t helps using merging text from one file wnto another file by using g, ;
. i . . N Mty
Mail-merge. Generating maihing labels is one of the examples of using i, In'
(N
12, MS Word provides a facility to check the spelling of words, |y put
. . N
colorful line under the words that ave mcorrect. 3
13, Tt helps you to automatically create a table of contents and index by q
. : ) - Ulse
on special codes that you msert in the document.
14, A built-in thesaurus allows vou to search for synonyms without leayy,
g

the word processor.

lemplate in MS Word

A template is a file that serves as a starting point for a new document. Whe,
vou open a template, it is pre-formatted in some way.

When vou Choose File = New in Word 2007 or 2010 vou get something like

the dialog windows below:

78 (9th)

word 9000 keeps 1ts built-in templates elsewhere, If you want your template
Jhow up ander the tab for “Letters & Faxes™ you need to create a folder
; . ; o ! .

) (itle in your user Pemplates folder, Just File — Save As and select

I
with thes - ile type. Before you
mphl'-" ga you! e B you save the template, create a new folder
(w wxes” i one Nt there, .
,IJ.“_{‘l'H & |1;|x1 8 l! { { thi.l’[ : 4”](] [.hpn open thd[ [U[d('l‘ E]nd atore your
lunl].:l:ll-l’ there.
“ 1 " L L (=
H ime A allabie rr'ﬂ.ll.\‘r!
1 nawe B s
[ p— p ~
J open y \.
4 e { \
*
o | &3 |
Recen! i Hhog et Farvern [P W T reasa S
e L ) e AN ) wabiny
_ (Mceann Fetmp late S
et
save & senl
- A grmla Aavan LY Bt g 1wl ot
H
) Optem Worg 2010 New Docurnent Wndow
EJ et
Cagierm Lrvnlipe Lsene e Fyen Foerm = |
e crnlonm

¢ 3.2 CREATING, SAVING, OPENING

We can create new file in MS Word. We can save and open the stored files

from MS Word.

321 Creating a New Document
o

To create a new document, follow one of the following methods :

1. Click on File —» New option.
2. Choose Blank Document Option.
3. Click on Create Button.
Or
Press Ctrl + N keys on the keyboard.

(9th) [_'_‘_5
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1 Red
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S ULIMe w

ith M.S, Word T

ate resume with MS Word Template perform the following

Click on New in File tab.

R4 o5 Document? - Mkcrosslt Word (Procuct Actvaton Faded) 3T
S e (reatits
bl e —— Blamd o pmnges 2 To cre
Biosen X
= ) e
@ e .
o o (I')
= Jases
Rcer? e =g sl —~TT T My eyt e
A g eToae
b 4 s
Pt
: | sty
Sre & Seme Yora | itstions
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b o covn Tropiaies - ::‘;
3 oo - 3 o | peters
S l'j d @ g (its
= . - . parieling
e ) . ] 4 peawt
== . | | psic
_s- . 1
_—& | pewsletters
Iig. Creating a New Document nott
- | faptis and Report
Open an Existing Document : To open an existing document use one of |t
e | gmes ana Covet
the following methods. ¥
l Sales
1. Click on open button from File Menu at the top left corner of the screen e
= 2 eddin
to open an existing document. Or [ ioe

Press Ctrl + O keys on the keyboard.

g Vg

b‘. & panih ML oest Oty » B

fesumes and Cover Letters 40| 1 2

To use
online
templates
pEase
upaale
COtfice

Gl onjme lempates
back

1

emplate

steps :

Get online templates back

becresaft Compostion
e

To use online templates
please update Office

Word Options

4 Resources
Check for Updates

For more information
type http://aka.ms/2007
in your browser .

o —
- o< g i
& Bt y 2
L # i
{ Hih* e
- L R .
o G
o e t
- P
[ v
- a— abiamn v
- = e — -
. ey
e - DR o e
ey
= . i o Jaziz e

Each of the above method will show the Open dialog box. Choose the file
and click the Open button,

(9th)

(i)

Select anyone according to the req

(9th)

select Resumes and Cover Letters.

(i) In office.com templates,

(i) MS-Word will download the selected template from office.com

templates.

1 2 P > r:.
(iv) Here various styles are available for Resumes and Cover Letters
uirements and click Download.

() Resume with selected template will appear.

4 __1 | 4 a4

Resumes and |
Cover Letters |

v
L

Personal

81 |




o =T il
, A
i - et oaline templates hack
e Rusines
~ To wee
T s el
il remmplates
ro—
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gty oy

Now we can edit | C
0 can edit it and can make the necessary changes in re
h S Sume,

<5y After filk : : . :
er filling all the required information in the resume, save it

Saving ] -
SAVINE & Aocumen

To save & new isti i
N or existing document that is opened follow
following methods. | et

T, ; ,
Click the Rave Option available on File Menu.

(oth!

\\--——

file is a new document then it will prom
pt you by openin
g Save As

if the
box.
tjllnlﬂg
. '_l iy Doty
rusted Lcharkaya de
J pepistes JCorel User Flles =7
B L _Data s
iy 3 o
@oet®  mmy DataScurcs  HSurinde
My _iMy M
| L pocusert -
{Banswet] Sy pases
§ compar -y Vides
™ el SO ot MNotehock 5
b il ke Files
21
)~
21+
=2
=4
=5
Fie gt Mave
save s TES wvord Document E
»
Tods  © | E j ]
L______a-——" I._..w

Fig. Save As dialogu box

the folder where you want to place your document, type the name of
nt in File Name Box and then click SAVE. On the other hand if
saved with a name earlier, it will simply save the

Select

the docume
the document 18 already

document.

Difference between Save aud Save As

Save Save As

Choosing "Save As.." brings up a
prompt to save your work as a file with
a different name. For example. you
might choose to save a document
called "text.doc” as ntextl.doc”. This
way, you can save you file at different
stages and keep multiple versions on

Choosing "Save" simply saves
vour work by updating the last
saved version of the file to match
the current version you see on your
screen.

L vour hard drive.
© =1
th) [ga]




3.2.3 Opening a Document

> o

- \ o I slops
We can open the the saved file. Follow the following steps (o open 4 il

1. Click on Open option.

g Chlem

o

1 C Poouments and Settings', WMy County
<« C\Doouments and Settings\.. \My Country
4 C'\Documents and Settings\. . \chapter 3

4 L \Doouments and Settings\.. \chapter 2
Exit

2. Select the file and click on it.
4. Then click on Open button.

1. The selected file will open.

o)
e
B ow " L]
Fiwrre Dabe rmnddued Tope
| g [ F10% oo 1n-an Vil Rleleq
| S — ! g
l ‘. R R e UFRL A TN ) File tehited
. Pt b Turmpute L0 WE T N OR Ve fuileley
' My ‘ Cerngniins 1] 605 3000 | ¥ il Basiriee
| -“I & tempane 17 26-0% 10 Y02 Vil Resloimsy
B " i b Holstle - Wikipede tie R LT il 4 u.f
! ‘ Ty .r: = By B el B TLRT RN Fide f00 e
| o | R e et it
| P ——— Wibipitis . 2000 J000 N0 Tt M1
o T =
R Plver et (G
- =53 vl e — '
P perie (500

(4tht

PRINT & PRINT PREVIEW
i

int : MS Word gives you complete control over how it prnt your document.
i either print to a printer or to a file. Before you print, you can preview
You can ument and specify which page you want to print. The main purpose
-"our:ducMS Word is to create a printed product. MS Word includes many tools
of ;i]ll:.?g making printing you need as €asy as possible.
to '

% i ument
3.8.1 Print a dor

Once you have completed your document, you may want to print it. The Print
view is an option that allowed you to see exactly what the document looked
El‘ke pefore printing it. This option is combined with the Print window to create
ike
the Print pane.

“iang £ rint your document :
Steps to p )

(i) Type a document in a blank page of MS Word.
(ii) Click on File — Print option or Click Ctrl + P.

] Hews | Praview and pniit the doroment
- el & pordar number of tops, Mg
7 G@pan | ather prnting options Befaie printing i {
B Quick Print l i
Save Sena Ihe document Qi ectly 1s the detauit i 1
e withaul making thange: s
|
| Ay ot Preyiew
H Saveds Lk Preview and make changes 15 page batere
grnting.

P Publish »

? Llote i
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G52 Yot e change any o name of pringer &s w 0@ and the
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41) If we select on Current page option we will take the print of desires
page. We can also mention the page no. by clicking on Pages option. We can

also take the print out of all the pages through All option.

ﬁ‘-'
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Uy

gpe 88
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y You can alse change the size
"

of pa ~ )
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(iii) You can Type the range of of page as shown in the figure,

i ' sl

-
[T lba
o

|

[ —— by "

o p— g e s ®|

(1) You can see the Print Preview of document.

’ .
J3.0.2 Preview a document

Print preview is a function provided for displaying a page, document or any
other material before it is sent to a printer. Print preview is a useful function
to users asat helps them to see how the final printed material will appear. It
also gives the user the opportunity to check or adjust the layout or resolve any
1ssues before printing the material to achieve the intended final form.

Perform the following steps to check the print preview of a document ;
1. Chick on File menu -» Print Preview option. Or

Chek on Print Preview button from standard tool bar.
[Somimentt vt woeeniwes - LSS

- e e e T .
aBEE v AN E e

Fig. Page Setup box (Margin Tab)
2. Chick on close button,
(s8] (Oth)

9.4 CLOSING OF DOCUMENT

you can also close a.docu ment by clicking on the Close button on the right
e of the document window. This button looks like the red X shown in the
gi

gqure belo™
perform the following steps to Close Word Document :

1, Click on File

9. Click on Fxit menu Or

Press Alt + 4 Or

Click on Close button of Title Bar.

Fig. Closing option

3.5 EDITING A DOCUMENT IN MS WORD (CUT, COPY,
PASTE)

9,51 Editing a document text in MS Word

Making changes in a document like inserting or deleting text, copying or
moving text, replacing text, etc. is called Text Editing. To make changes in
the block of text, it 1s necessary to select it. You can select a word, line,
paragraph or entire document text.

1. To Select a Word : Place the mouse pointer on the word to be selected
and double click the left mouse button to select that word. The selected word
will appear in reverse color.

. L - » -
| #% & comnsonmn 0 & B % B8 4 L
'y sy - BEREY it
Masts P TR T ™ AN " (1P | R
e et e "
| .

like insarting ar deleting text, copviig oF

Making changes m a document
meving text, replacing text #te s called Tost Edinng. T make changes

ey 1o seleot 11 You can wievt a word, L

e

B et el

. & v PRI

|1 the Block of LEXT it 18 hrcessa
| paragraph orentire doctument text
. I ———— —————
Pagy Lol Vordi- ok LRQM el o~ !:.-.i | =
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lo solect a bine - Bring the mouse pointer to the begimning of (], liy
I . : , : . [
in the left margin. Click the left mouse button to select the line,
Lo WG i
. W B TR e Wil "
& S s "'N..&MH
4 d '4‘. - ".."F" Gk Ehaa Koy
n '“, h .,. 3] hi Ppagt A
fra
»
{
Meizine <hanges i & decusnent liee gaecting o deleTing ey, copyins or
WVIRE X1, ~aplacing text. ¢1c s called Text Editing. To moke changes i 8
ey [ hExE 3 i pecessary b select 1t You can select o word, line '
{ parags enkiy 4 e LAY r |
!.;:-‘:I - ¢ St _.....-._..F:ﬂ'“-’*-ia"“
+ ._‘:.r L Mp’v‘\ﬁ-:'i".; _l\ .}‘Q; . il vt |

Keep the mouse pointer anywhere within the
paragraph and mple click left mouse button to select that paragraph,

‘_"'\_' -2 -‘v%'-.‘. Simrashriven) - - -
.2 oty Fageitres 1-«*& - Saaret 'Mlh o I -u
ol Ve, T e '
' : ¥~ "3' .- a.
e L -o-‘tv:w Mo
=3 Ve N R ﬂ' ol ::::‘ﬂ o
- - "h‘#-r- e

ety compey L2 ASTTeTS UQ- inseruny or deleniag texy, capying or

BT 20, THRIAC T deKY, eIk dx osked Twix Editing. To make clinuges in
e S «.hu:.. 2 errmbay W pelect it You enn saloct 0 word, Ene
rarwerEpk o2 Batice Scommen: texs ‘

[ sk
ok 18

- & » 4 TS -
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- You can move th
e selected text fro
to the new destination in the document. s xting poston

1O

(i) Select the text to be moved.

)

(h)

(ii) ¢ l Paste
Hul“" tah . .
\ - " | " 1 1
|.hl{ i The 8 Jocted text will disappear from the document. | &~ Cut
1 i

. s |
iv) pring the ¢ ursor to the new position where you want  — /
:h i-t h(- l(‘)&t
o ) C lick Paste option from the Clipboard group.
(v

(o) The text will appear at the cursor position
4

Flapoes 5

« Copyine et - This feature of Microsoft word 2007 helps to reduce the
e N . . . - .
il and efforts involved in re-typing the similar text. Using this you can copy
1
“he soxt from one location to another. keeping the text at original place
t
nchanged
To cOPY the text keep the following steps in mind :
@) Gelect the text to be copied.

(i) Click Copy option in the clipboard group under the

Paste
Home T ab .

(iif) Bring the cursor to the new location where you want
to copy the text.

(iv) Click paste option in the clipboard group.

6. Font : A font is a set of printable or displayable text characters 1n a

specific face and size. The type design for a set of fonts is the font face/ typeface.

Calitny » - Y - -
| Thewmre Fanis &~ - b ] = ‘
Cambria . a -
Calibri a
Plwe mrity Lleed Frmts
i 11
ap wvosr il i
{:ur:.r".m L
£ hwney Hi 18
 ALBERIAN 18
o oy sl T bt
€ Arial 22
€ Arisl Black 24
£ Anal Blar o~ %
' Arial Rounded MT Bold 28
f’ Arial Unicods M5 1
& A o e B B 48
 AvontGarde Md BT i
€ Baskers e ¢kl Face

Fig. Font Face Fig. Font Size
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7. Modifving t t fonts wi

.. 1o - The Font Group allow, s
any other elements.

g 3 t { , 0 ch.
. an,
our text font style. size, color and m *r

o - s
) ) - LR st 0
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. e sam 7 " ity
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et e
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o e
L
by SouETONS WL SEES TO CREATE. DEMAY Asg
T ALsAERAS mtmmh_\ulm“mm
o iiind FOMMAT TLLT (8 ADATIZS 79 MALZ OL¥ OoCLamgsy “’l
P APPLALSS PORSLATTED TELTCAL DRAK mﬁlu..‘
P . ATTENTION T SPEOUNC PARTS OF THE SoCiomsy e .ml
¢ SRR ATE OLE IEISASL
€ Bl Wragmatet MT Soic
o | mixnae M3
—

" 1w, Modifying text by using font option
mte] o0 Text : Perform the following steps :
(1) Select the text you want to modify.

(it) Click on the font face, from the drop down list select the style anq gy,
size simultaneously.
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1. Modify Font Face and Font Size
OR

Press Ctrl = [ decrease the font size and Ctrl — | increase the size of text
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Fiu. Increase font and Reduce font

[ 44 (o

-k

» Cut, Copy and Paste
g,0.%
jfwe have to remove text from our document, we can
or cut the text from the document. First Seleet the -
cop¥ nd g0 10 the Home tab in the Clipboard group - R —
; z 5
te‘t ” ] . . » e o T —
Click Cut or Copy option in the Clipboard group. Pasts @ Copy
(v . J Format Samtes

OR

We can also right click on our mouse and select Cut or Copy.
OR

We can also press Ctrl+X (cut) and Ctrl+C (copy) simultaneously from

oboard #n
(ii) Pasting Text : If we Copy text, then we have o O B
¥ £ C g oy
10 Paste it somewhere in the same document or -

other document. Click the Paste Option in the P i
(lipboard group.
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We can also right click on our mouse and select Wik, Pusie optici
paste option.
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I'ig. By Right clicking on mouse . Paste option
OR
We can also press Ctrl +V simultaneously from keyboard.

(]

(©ih)



‘\_‘\ L.'.HL‘ '8 ort Page Lavout
" orfo 3 ‘1 )
This command reverse the action we have per formed while Udmng [t’“ g Calbrl BOOYT < 16 E LYR
M We can co 2 r
make an error i our document or edining text then correct it by — & Italic

hk

on the Undo command. it will remove the last thing we did. Quick Acgg
=
Toolbar provide this command. Shorteut Key for undo 1s Ctrl + 7,

e T
Bold jralic Underline
3.5.4 Redo

'%. Bold. Italic. Underline option
To reverse vour last action. press CTRL+Z. To reverse your last Undg, Dy

n Usineg Keyboard Shorteut @ § F 2
CTRL=Y. You can reverse more than one action that has been undone, Yo, i) Using vk e oime Shorbost esmmands
can use Redo command only after Undo command. e Pkl
€ FO TT DOCUMENT Ixmn!;hne —
3.6 A NG A T
RMATTING I i Ctrl + U

Formatting a document means modifying text size. font face. color, sty
alignment. line spacing. graphics and many more things. Microsoft \\@»
provides many easv ways to add creativiry to any document. Do the f(;.um,nti (i) Font color : If vou want to type text in anv colour of vour choice then
steps : ‘ vou need to choose font color option in font group of home tab. There are

;following steps to change font color of text.

6.3 Fill Color

() Select the text you want to modify.

There are three basic font styles used in text. These are following:
Bold Beold text, means using thicker letters. . Himachal Pardesh School Education
Iralic text. means using slanted letters. l Board Dharmshala

~nocr.ne Underline the text. means to draw a horizontal lis: [
underneath the letters. |

3.6.2 Bold, Italie, Underline : Fig. Selected Text/Highlighted Text
Onee text is highlighted we can also click on the bold. jtalics or underi® (if) Click on the Home tab. Choose the Font color option in the Font group.
commands to modify the text style from font group in the home tab. The Font Color drop down box appears.
OR ‘da.y . Documentl - Microsoft Word

Press Crl « B. Curl + L Crl + hﬁw/rm apelayt  Refereces  Madngs  Revien  Vew

italics or underline.

U simultaneously from keyboard for b
Fig. Home Tab
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arious font colors. A |4
(iif) Move the mouse pointer over the vari ve p“ﬂ\riaw
he colors will appear in the document.
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i iz, Color option
(iv) Select the colour according to vour choice.
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Highl

i Text

When vou use text highlight color option, it means that the text shows lik
- was marked with a highlighter pen. Steps to use the text highlight color ar
sHowing -

(1) Select the text that you want to highlight,

(tt) On the Home tab, move the arrow next to Text Highlight Color in th
‘unt group.
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lick the color that you require for text,
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Fig. Text highlight color

$3.7 ALIGNMENT OF TEXT (LEFT, RIGHT, CENTER &
JUSTIFIED)

Paragraph formatting
text size, font face, color, style,

Formatting a document means modifying i :
things. Microsoft Word provides

alignment, line spacing, graphics and many more

many easy ways to add creativity to any document.

7.1 Change text alignment

(i) Select the text you want to modify.
: on
(i) Select one of the four alignment options from the Paragraph group

the Home tab.

r "1

2 Align Text Left

, o L
Aligns all selected text to the left margin. (Press Curl+L)
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.7.3 Align Text Center
] ress SIINERD
Aligns all selected text to the Center margin. (Press Ctri+)
3.7.4 Align Text “.i_!,l‘-‘n
. pags (tr ’
Aligns all selected text to the right margin. (Press Ctel¥R)
1.0 Justify

Aligns text equally on both sides and lines up equally to the right

zines. (Press Ctrl+,] nd l
margins; used by many newspapers and maga # )

Align means to make strength. Align is of four types :

1 e~
ilndia is a nation with great cultural hentage._lmge reserveg
of natural beauty. human resources and relatmnshm\J

Fig. Left Alignment
India is a nation with great cultural heritage, huge
l reserves of natural beauty, human resources and
| relationship |

Fig. Right Alignment

India is a nation with great cultural heritage, huge
‘“ reserves of natural beauty, human resources and
| relationship |

Fig, Centre Alignment

dia is a nation with great cultw | heritage, huge

eserves of natural beauty, human resources and
relationship.

Fig, Justify
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1eft alignment  Center alignment Justify alignment
Right alignment

Fig, Text Algnments
¢ 3.8 MARG[N.‘% - LEFT, RIGHT, TOP AND BOTOTM

margin is a space separating text or other elements from the edge of the
& com monly adjusted through the page setup. Most programs allow for the
aper

pottom, left, and right margins to be set. The standard margin settings
0P rop and bottom and 1.25" left and right.
are

page Setup : With page setup we can adjust size of the page and
age D€L
margin-

Perform the following steps for Page Setup :

1. Click on File — Page Setup menu.
Eile i
O New.. Cri+N
‘= Qpen.. Cri+O

Close

‘& Save Cri+s
ﬁ _ﬁ;mt Preview
& pint Cul+p

fig. File Menu
= sides.
2. Click on Margin button and set margin on all sides
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3. Click on Paper button and set size of paper (As Ad or Lega)y
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Fig. Page setup box
4. Chck on "OK button.

& 3.9 CUSTAMIZED LINE SPACING

The simple way to change the line spacing for whole document is to highligh
or select the paragraphs or entire document that you want to change the line
spacing on. Adjusting the line spacing will affect how easily our document can

be read. You can increase spacing to improve readability, or reduce it to fit more
text on the page.
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" gelect the text you want to format.
(i) Click the Line and Paragraph Spacing command in the Paragraph group
1 the Home tab-
{ . : 3
(iid) Select the desired spacing option from the drop-down menu.

(iv) From the dropjdown menu, you can also select Line Spacing Options to
o the paragraph dialog box. From here, you can adjust the line spacing with
E\reﬂ more precision.
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i Paragraph dialog box

When you select at least or exactly in the Paragraph f:lial_ag box. the line
spacing is measured in points. Otherwise, it is measured in lines.
; " i i
It is to note that you can quickly display the "Paragraph . dm;og;)ot::;:d;:ht
and Spacing tab) by clicking on the dialog box launcher in the bo
corner of this group.

43.10 ADDING HEADER AND FOOTER

e in an electronic document or

N a ’
Headors : A header is text at the top of 2 P gheader could be created in a

hard copy. For example, in Microsoft Wor; & er of each page.
document to display the page number in the top corn
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A footer is at the bottom of a page In an Sletoie dﬁcumeht Jiew e —e
- . o
hard copy. ; W e
Headers, footers and page numbers can = add:?tll:zlsg :1:“:; o Th, & Sookma | 3
simplest way is to double click on the top or bOtt.-or:to be dis ixv !cli Wi hea & e 08 ;'“""“‘
and footer area will appear. Enter the text youwis blayed at thq top, s Number =
bottom of every page. : I01E
- 3 I"ie. Header and Footer Tools
/ (iii) Type text in the header or footer area.
- = (iv) To return to the body of your document, click Close Header and Footer
o » the Design tab (under Header & Footer Tools),
o
R — Removing | rs and footers : Do the following steps
S ' Click on Insert — Header & Footer — Header or Footer.
““'\ : (i) Click on the Header, Footer or Page Number Command in Header &

Footer group on Insert Tab.
=:.-.:.. Worde 43 | O3 [10la 3 m - 2 '
i ji) A drop down menu will appear.
Figz. Displaying Header and Footers in the Page (i)

; ; (iii) Click Remove button at the bottom of the menu.
It is to note that after typing text in the header or footer area, Close Header

and Footer on the Design tab (under Header & Footer Tools). § 5 A 3 K. > a2 F
g o i X S 1 = L g - EHow n
a o ‘:‘ et - 0“
ST :
- o B -
[T Different = st Page l_-§1 Header from Tog: 05 = a ; o
~ Different Odo & Even Pages | ) Foote from Bottom: (15" L il S R ok (Thrae Conamne)
IF Show Document Tex :]Ense-‘: Alignment Tan Ld:e;i\::el " T s
sition Gl -
T ——— kiphaser
Iig. Close Header and Footer i
-2 The e 1
Steps to add Header or Footep : _ o = =
i . Rzl O e . 43 ¢ Lokt Uoawes 15 (e
(i) On the Insert tab, in the H : ' ' ;
_—— eader & Footer group, click Header or Foote" g - -
(ii) Click the header or footer that . d Z
our header or foote i You want to add in your document a7 :
¥ r area will open, iz, Remove headers I'ie. Remove footers
[ T‘Tz- (@bl (Sth)
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1. Click on View —» Header and Footer menu. The Toolbar wil g,
. T,

2. You will see frame on each upper and lower side. Fill page Nump,

. er |
header, click on insert page number button of tool bar. In

3. Click on Insert page number button.

Show
Show N
AutoText Button mgﬁc F"m tr‘:ge Page Setup Preview ot
i . ]
H'E'-%k' anl Footer j i \ / -
4 & r e [=). v -1
Ingert AutoText- = 2 & B9 &Y A4 = v Clpse
/ J \
§ Insert (oo \
Inser‘tc number Date e / Switch between  Close Button
we Show/Hide Header and
. Footer
Document Text

i Header and Footer Toolbar
& 3.11 PAGE NUMBER
A page number is the number of the specific page in a document. The
document may be printed like a Microsoft Word document. The page number
is usually located at the bottom of the page, but sometimes can be found in

the upper left or upper-right corner of the document. In printed beoks, page
number one is usually the first page of the first chapter in the book.

ms word chapter 4 - Microsoft Werd

pr—"

Piain Nogmiber L

Fiain Number

1. Displaying Page Number option

104 | (9th!

q.11 A
{f you want to put a page number on each pa

from the gallery. £€, you can quickly add a page

utﬂber p
) On the Insert tab, in the Header & Footer group, click Page Number
(i) Click the page number location that you want. (Top of page or Bottom
of page}

) In the gallery, scroll through the options, and then click the page
amber format that you want.
n

2 11.2 Remo’

[f you want to remove page number, which already added. Do the following
steps:

(i) On the Insert tab, in the Header & Footer group, click Page Number.

) Click the “Remove page Number” option.
&3.12 USING GRAMMAR AND SPELL CHECK UTILITY

It's important to spot and correct any spelling mistakes or grammatical errors
you've made In MS Word. You can let Word's spelling and grammar checkers
suggest corrections automatically while you work. You can check the spelling
and grammar in the file all at once when you've finished writing your document.
Microsoft Word 2010 comes with a dictionary of standard grammar and
spellings, but they are not comprehensive.

1. Click the Review tab on menu bar.
2. Click Spelling or Spelling & Grammar.

n T e

ARC

=2

J Thesaurds

Speting &
Grarnmiar S5 Wword Count

I

112 Spelling and grammar button on the Review ribbon

(9th) 208
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melhog CHOUNET
3 wpelling (EDONNE 18, 344
vo the MESSpeling pBClnas I add;

o Sems yOUTr GoCUment with

Tizle by Zaspless 1he name of the dOCUMENT and ithe name o b
EOETaT

£ MS Word 2003, New Version of u:
woon system In place of dropdown meny;:

Druzlog vox lwoncner 1z very small arrow that displays on the b

Bivhon,

Tzxz or Work 2rez = the zres whers Vou 1¥pe your text,

y

vericzl ey iz o2l

z.120 the insertion point or cursor,

Frme Layoas vew deplays pages exactly as they will appesr whe
e
¥

ull Bereer Fezding v ot 2 Tl o
“saling view gives 3 full sereen look of the document.
" § prwepar aes y il
_".g‘ BT W shows how 3 dorument Bppears when viewed by ¢
Wek browser, such s [nvernes Explorer
Yo czn use Draft view —
0 > Draht view 1 quickly ogjs your document. Draft view i 15

msst frequently used view

” 7 Blider 1re
Tre Zewssn Blide WATEAes Of decreapey the viewing area
PN 20 existing durument.

- |

Carl + O keys ape ke 1
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T
EXERCISE )
e Type G tions .
window explorer is used to view :
2) Files (o) Folders
¢c) Both (2) and (b) {d} None of zabhave

We can see drives, files and folders in -

/5) Address box b) Left pane
; ) Address box (d) Menu bar
Word template include :

{a) Resume (b) Agenda

{c) Business card (d) All the above

Microsoft world provides many easy wavtoadd ... in any document:
(z) Picrure (b) Creatvity

(c) Clip {d) None of abowve
Shorteut command for italic is :
{fayCtrl+ B

(c)Ctrl+ U

(b)Cirl+1
{d) None of above

® True or False

4

J.

‘iﬂh )

By -

We can measure the text and graphic with ruler. gt
When you start word, you see document. =
The document is saved in primary memory of the computer. e

You cannot get print out of the recorded data. ||
If we copy text then we have to paste it ine where 1s the same d.ocum:n_t
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| What is window explorer ?
Name the parts of window explorer.
What do you mean by formatting a document ?
I. What is undo command ?
Y. .Name the ti,l.lree. baflc f_‘c-mt. Tc:ty%es used in text. DIGITAL PR l‘:“"\EZ\LE‘I\TIO.N )
| ke ' POWERPOINT
) i;w vou will start MS Word ? " Q. D - Q D ; m € §‘§Q B ﬁ_ﬁ?}a
at are the uses of MS Word ? : T .
What are the style to create a document in MS Word ? Objective of Learnia
How vou will open a document ? 41 MS Powe aint = Introdiceti
. What are the steps for page set up ? 49 Creatin
Describe the parts of MS Word screen. 44 Different Elements of Siide I
2. How you will create a resume in MS Word template 7 4.5 Different Typesof Viewofa Slid 1 Slide So S
How you will print and preview a document ? 4.6 LEditing and Formatiing of Slide
|, How you edit and format a document text ? 47 Addin vd Sub Titles, 1
5. How you will format the line spacing ? 48 H Fox N
How you will add and remove the header and footer ? 4.9 Inserting nS

4,10 Design Templates
}*}>’)){ Answers Key ' »i bl Animations. Sound & Transition Effects

l.éc) ;Botlh (a) and (b), 2. (b) Left pane, 3. (d) All the above, 4. (a) Pict™® | & 4 1 \1q pOWERPOINT : INTRODUCTION TO POWERPOINT
-+ . N I\ s AINE
5. (b) Ctr ; re used to make presentations.

1. True, 2. True, 3. False, 4. False Presentation software is an application softwa i
£8 Ralee, /J These ¢ tation software like Microsoft PowerPoint, Open
ays many presentatio in market. In this

Office.org Impress (Open source), Si ;
hapter we will discuss PowerPoint in detail

de Rocket are available
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